
Workshare 9.5.4   |   September 2018   |   9.5.800.4210

Workshare Compare 9.5

Release Notes



Workshare Compare 9.5 Release Notes

2

Table of Contents

What is Workshare Compare.......................................................................................... 3

What’s New in Workshare Compare 9.5 ......................................................................... 4

Workshare Compare 9.5.4 ..........................................................................................4

Workshare Compare 9.5.3 ..........................................................................................4

Workshare Compare 9.5.2 ..........................................................................................5

Workshare Compare 9.5.1 ..........................................................................................5

Workshare Compare 9.5 GA .......................................................................................5

System Requirements .................................................................................................... 6

Certified Environments for Workshare 9.5 (32-bit version)...........................................7

Certified Environments for Workshare 9.5 (64-bit version)...........................................9

Important Information.................................................................................................... 10

Important installation information...............................................................................11

Change Requests Fixed ............................................................................................... 11

Workshare Compare 9.5.4 ..................................................................................... 11

Workshare Compare 9.5.3 ..................................................................................... 15

Workshare Compare 9.5.2 ..................................................................................... 16

Workshare Compare 9.5.1 ..................................................................................... 17

Workshare Compare 9.5 GA .................................................................................. 17

Known Issues ............................................................................................................... 18

Contact Info .................................................................................................................. 20



Workshare Compare 9.5 Release Notes

3

What is Workshare Compare

Workshare Compare reimagines multi-party review and collaboration and ensures the safe 
and accurate exchange of information, enabling the collaborative evolution of high value 
business documents. 

Workshare Compare is a desktop application that automates managing changes to 
business documents.

Key features of Workshare Compare include:

 Comparison of Word, PowerPoint and PDF files, including image-based PDF files

 Comparison of selected pieces of content, such as a single paragraph or clause

 Ability to accept/reject in a comparison and then create new documents

 Advanced comparison features for Word and PDF files including one-to-many 
comparisons, version comparisons, and access from within Word and PowerPoint
files

 Change notifications in Outlook to alert users to changes in received attachments

 Conversion from PDF to DOC format for local files and from within the DMS/CRM

 Options to save and share Office documents to Workshare online

 Access and visibility into online collaborative workspaces directly from Office

 Secure file sharing from all devices and browsers with metadata removal and end-
to-end encryption

 ECM/DMS and OCR integration with desktop comparison features

 Centralized user account management and control

 Complete access to Workshare online functionality to share and collaborate on 
documents, including setting folder access and permissions, positional commenting 
and reviewer communications with presence indicators

 Desktop sync app to synchronize your online content to your local desktop

Note: Workshare Compare can be installed without Microsoft Office integration. In this 
case, the comparison functionality is only available from the Workshare Compare 
application.
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What’s New in Workshare Compare 9.5

Workshare Compare 9.5 is a 32-bit and 64-bit release that focuses on improving 
performance. It includes the following new features:

Workshare Compare 9.5.4

This is a maintenance release which fixes a number of issues. See Change Requests 
Fixed for more details.

Workshare Compare 9.5.3

 Selective Compare:

The new Selective Compare feature, available from the Workshare tab in Microsoft 
Word, enables the user to copy snippets of text from anywhere and run a 
comparison in Workshare. This is much faster and more focused than comparing 
an entire document. Users can use Selective Compare to run a comparison on
snippets of content pasted from emails, chats or files. Content can include text,
tables, code and images and results are displayed in the familiar Compare 
environment.

 Comparing presentations:

Comparisons of presentations are now saved as WCFP files. This file type can be 
opened in Workshare Compare for PowerPoint. This avoids any conflict with the 
WordPerfect .wpf extension.

 Installation

The NetDocuments ndOffice msi is no longer included in the Workshare installation 
bundle. Instead, it is a requirement that ndOffice must be installed in order to use 
the Workshare NetDocuments integration. Thist is to ensure the latest version of 
ndOffice is installed and brings the NetDocuments integration in line with our other 
integrations.
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Workshare Compare 9.5.2

 Environments:

 Added support for OpenText DM 16.2

 Restored support for IBM Notes 9.0.1 FP7, FP8 and FP9

Note: Interactive Protect and the replace email attachment with link features of 
Workshare are not supported in a Notes environment.

Workshare Compare 9.5.1

 Environments:

 Added support for iManage Work 10

This is just the first part of integration to iManage Work 10, mainly aimed at the 
users who are using it on their desktops in the office through the Work 10 for Office
client, or still using earlier versions of Filesite/Desksite with the Work 10 server.

Note: This release does not support Notes environments.

Workshare Compare 9.5 GA

 Provides better and faster comparison:

 Improved table comparisons to make the comparison easier to read, giving 
more focus to the text changes when the table structure has changed (cells 
being split and merged).

 Changes to the way some UI components, such as the progress bar and 
Change Summary window, are loaded during the comparison. This speeds up 
comparison time and Workshare is quicker than the competition for almost all 
sizes of documents.

 Improved OCR engine so better PDF comparison.

 Includes updated rendering sets:

All of the Workshare rendering sets compare comments and images by default.

 Enhances the performance of ACN (Automatic Change Notification):

Completely changed technology behind ACN so it’s more robust and more reliable. 
The UI has also been updated so it is easier to use.
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 Provides faster synchronization time:

Improvements to both uploads and downloads by increasing the minimum number 
of sync threads from 1 to 4, improving the access to the database and not 
processing redundant activities. Now entire matters can be synced to replace 
USB/CD delivery.

Also UI improvement to keep users informed in the desktop app of sync progress.

 Aligns the 32-bit and 64-bit versions

 Improves licensing:

No more interruption for users when they are in a licensed state and no more
purchase links for end-users. A less intrusive renewal message is displayed only 
after the license term expires. There is also differentiation in the messaging for trial 
and paid users.

Workshare Compare 9.5 also includes the following changes in environment support, 
installation and configuration:

 Environments:

 Dropped support for Office 2007

 Added support for Windows Server 2016; dropped support for Windows Server 
2008.

Note: This release does not support Notes environments.

 Installation:

 Reduction in MSIs and add-ins: Only one add-in in Outlook now and one less 
MSI to install.

System Requirements

The recommended system requirements for Workshare Compare 9.5 are:

 Intel Core i3 @ 2.5GHz

 AMD Athlon 64 X4

 4GB RAM

Workshare 9.5 has a 32-bit version for 32-bit Microsoft Office environments and a 64-bit 
version for 64-bit Office environments.
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Certified Environments for Workshare 9.5 (32-bit version)

Workshare 9.5 (32-bit version) has been tested and certified in a number of environments. 
If your environment is not included in the following list, it may still be a compatible 
environment. Contact Workshare Customer Support (support@workshare.com) for any 
help.

For details of which environments previous versions of Workshare Professional/Compare/
Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (32 bit and 64 bit)

 Microsoft Windows 8.1 (32 bit and 64 bit) + Japanese

 Microsoft Windows 7 SP1 (32 bit and 64 bit) + Chinese Simplified & French

Citrix:

 With Microsoft Windows Server 2012 R2 or 2016 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 2016 (32 bit) – including click-to-run

 Microsoft Office 2013 SP1 (32 bit) + Japanese – including click-to-run

 Microsoft Office 2010 SP2 (32 bit) + Chinese Simplified & French

Email System:

 Microsoft Outlook 2016 (32 bit)

 Microsoft Outlook 2013 SP1 (32 bit) + Japanese

 Microsoft Outlook 2010 SP2 (32 bit) + Chinese Simplified & French

 IBM Notes 9.0.1 FP7, FP8 and FP9

Note: Interactive Protect and the replace email attachment with link features of 
Workshare are not supported in a Notes environment.

mailto:support@workshare.com
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Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version

Microsoft SharePoint:

 Microsoft SharePoint 2013 SP1

DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.0 Update 6 and above

 Work 10 Desktop for Windows 10.0 and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use an iManage Work 10 server, it must be installed on-premise or in 
an iManage private cloud. If it’s a Work 10.2 server, it must include iManage Work 
Web Server 10.2.0.91.

 OpenText: 

 eDOCS DM 16.2

 eDOCS DM 10

 eDOCS DM 5.3.1 COM only (Patch 6)

 Worldox:

 GX4

Workshare will endeavor to support future service packs of certified environments.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
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Certified Environments for Workshare 9.5 (64-bit version)

Workshare 9.5 (64-bit version) has been tested and certified in a number of environments. 
If your environment is not included in the following list, it may still be a compatible 
environment. Contact Workshare Customer Support (support@workshare.com) for any 
help.

For details of which environments previous versions of Workshare Professional/
Compare/Protect were certified against, refer to previous versions of release notes on the 
knowledge base.

Note: Unless otherwise stated, all environments are the English version with the en-us 
language set.

Operating System:

 Microsoft Windows 10 (64 bit)

Citrix:

 With Microsoft Windows Server 2012 R2 (64 bit)

 Citrix XenApp 7.5 

 Citrix XenDesktop 7.5

Note: Check with your Citrix vendor about which Windows operating system supports 
your version of Citrix. 

Microsoft Office System:

 Microsoft Office 2016 (64 bit) – including click-to-run

Email System:

 Microsoft Outlook 2016 (64 bit)

Browsers:

 Microsoft Edge, latest version

 Microsoft Internet Explorer 11

 Google Chrome, latest version

 Mozilla Firefox, latest version

mailto:support@workshare.com
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DMS Integration:

Note: Check with your DMS vendor about which Windows operating system supports 
your DMS. 

 NetDocuments

ndOffice must be installed to use the Workshare NetDocuments integration.

Note: If you want Workshare to be available when using the NetDocuments Send 
to application functionality, Microsoft Internet Explorer must be installed 
(although it does not have to be the default browser).

 iManage clients:

 FileSite/DeskSite 9.3 (64 bit) and above

 Work 10 Desktop for Windows 10.0 (64 bit) and above

 Work 10 web client (You will need to install Workshare iManage Integration 
Server in order to launch comparisons from the iManage browser interface.)

Note: If you use an iManage Work 10 server, it must be installed on-premise or in 
an iManage private cloud. If it’s a Work 10.2 server, it must include iManage Work 
Web Server 10.2.0.91.

 OpenText: 

 eDOCS DM 16.2

 eDOCS DM 10 (64 bit)

Workshare will endeavor to support future service packs of certified environments.

Important Information

Secure PDFs – Workshare Compare is unable to compare secure PDFs or convert secure 
PDFs to Word format. Secure PDFs are PDF files with security settings configured.

OpenText DMS – When you have the Workshare 9.5 integration with OpenText installed 
in a Windows 7 environment, you may experience issues such as the inability to browse 
for files from eDOCS or eDOCS crashing.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
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Note: Workshare is aware of an issue where OpenText eDOCS DM becomes unusable 
(for example, it is not possible to browse for files from eDOCS or eDOCS is crashing) 
when Workshare 9.5 is installed and the screen resolution of your Windows display 
settings is higher than 100%. Investigations have shown that this issue only occurs in 
Windows 7 operating systems when you have added WDF as a file type in the OpenText 
Application Management console. Workshare and OpenText are working together to 
understand the root cause of the issue and provide a solution. For further information, 
see this article in the Workshare knowledge base.

Important installation information

 Workshare Compare installs program files to a sub-folder within the Workshare 
folder named Modules.

 Install: A user is unable to install Workshare Compare if Microsoft Windows 
Installer 3.1 is not installed. This can be downloaded from the following location 
https://www.microsoft.com/en-us/download/details.aspx?id=25.

 Windows 7: When UAC is set to Default, running the Workshare Compare install 
displays the UAC prompt. You must approve the prompt and Workshare Compare
will be installed. Running the Workshare Compare MSI silently will fail when UAC is 
set to Default because the user is not given the opportunity to approve the UAC 
prompt. Therefore for silent installs, disable UAC.

If you have installed any Alpha or Beta builds of Workshare Compare, we strongly 
recommend that you first uninstall them before installing Workshare Compare 9.5.

Change Requests Fixed

The following are fixed customer change requests that have been validated for this release 
- for more information, please contact Customer Support.

Workshare Compare 9.5.4

The following are fixed customer change requests that have been validated for the 
Workshare 9.5.4 release:

CR# Ref Description

PRO-110 CR01099571 Floating 'Change Summary' panel causing Compare to 
crash

PRO-591 CR01120269 Right- click menu is severely lagged when Workshare is 
integrated with OpenText.

http://workshare.force.com/knowledgebase/articles/Troubleshooting_Article/OpenText-eDOCS-DM-is-unusable-when-display-settings-are-set-above-100
https://www.microsoft.com/en-us/download/details.aspx?id=25
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CR# Ref Description

PRO-619 CR01120337 Compare for PowerPoint 2.2.4130.0: PowerPoint 
Comparison Report shows side-by-side instead of 
horizontal when printing to PDF

PRO-622 CR01121326 Comparison failed when documents containing comments 
and 'Display comments in redline' rendering option is 
enabled

PRO-655 Footer is incorrectly rendered in the redline when specific 
documents are compared.

PRO-702 CR01126699 Error: "The following changes will not be applied to your 
document" when accepting comments changes in change 
summary pane

PRO-739 CR01127177 Original document does not get attached to Outlook when 
emailing original and modified documents that have the 
same document name

PRO-760 CR01129657 Workshare was unable to create a reply. Ensure that your 
default mail program in internet explorer is set correctly

PRO-786 CR01130122 Outlook warning message "Want to save your changes?" 
when closing email and Workshare add-in is being enabled

PRO-790 CR01087251 Table cells in TER not readjusting to accommodate the 
additional text created during a comparison.

PRO-802 CR01065327 Paragraph styles change to 'Normal' when cleaning 
reviewers in track change documents

PRO-834 CR00175543 Change Bars are not retained when converting to PDF 
from Compare ribbon

PRO-864 CR01086046 Redline displayed with text highlighted in black background

PRO-865 CR01085092 Incorrect/Misleading Bullet point insertions and deletions

PRO-869 CR01076568 Member not found' error displayed when forwarding emails 
containing linked images in the signature

PRO-880 CR01084799 Incorrect rendering of List numbering containing square 
brackets

PRO-941 CR01131807 Workshare crashes when comparing certain documents

PRO-952 CR01132182 Attachments are not been populated when emailing redline 
within compare

PRO-985 CR01133118 Return to 'document selection screen' when comparing 
from the desktop shortcut

PRO-987 Deleting default rendering set(s) forces a repair of 
Compare when relaunching the WCM.
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CR# Ref Description

PRO-989 Selective Compare - Full text is not being displayed in 
Original/Modified boxes when the text is copied from 
different sources.

PRO-998 Unable to perform workshare actions from FileSite right 
click context menu when FileSite is configured with 2 
worksite servers using SAML & Normal method.

PRO-1065 New comparison crashes when user dragged Change 
Summary pane towards upward dock position in the 
previous Compare window.

PRO-1070 Crash is shown when printing the comparison report on 
PowerPoint comparison window.

PRO-1083 Selective Compare Focus is not shifted to selected 
application when Selective Compare window is in 
maximized state.

PRO-1084 Selective Compare window is not popped up from 
minimized state when user clicked on Selective Compare 
button.

PRO-1087 Selective Compare Text in the original or modified boxes is 
not maximized when user maximize the Selective Compare 
window.

PRO-1107 CR01136284 Copying text from Internet Explorer to "Selective Compare" 
window in Word shows as very small font size and text cut 
off

PRO-1136 CR01137311 
(Spike) 

Error message: Namespace is undefined when connecting 
to iManage Work 10 using Microsoft Azure single sign on

PRO-1138 CR01137511 Print options are limited to 'Comparison only' when 
switching layout to 'Comparison only'

PRO-1147 CR01137765 Unable to convert redline and save it into iManage Work 10

PRO-1154 CR01137915 Documents formatting is changing in TER view after 
performing other actions

PRO-1162 CR01138618 Uninstalling Workshare makes the iManage icons in Word 
and Outlook disappear

PRO-1259 Unable to perform Workshare actions from Filesite right 
click context menu when Filesite is configured with worksite 
servers using SAML/Normal method.

PRO-1275 CR01140073 "Unexpected Error. Illegal characters in path" when 
forwarding an email containing an .MSG attachment with 
quotation mark " in the subject field
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CR# Ref Description

PRO-1296 Unable to Compare PowerPoint documents when FileSite 
is configured with worksite servers using SAML/Normal 
method.

PRO-1297 CR01141162 Error message: Invalid file. The file you have been trying to 
upload is invalid. Please try to uploading a valid ZIP file 
when uploading Workshare's Office Extension to iManage 
Work 10 server

PRO-1298 CR01141137 Incorrect version of OpenText displayed in the 'Save as' 
dialogue box

PRO-1376 OS Build' property is not displayed in Mixpanel events 
triggered related to Compare for PowerPoint and Selective 
Compare.

PRO-1377 No Permissions...' error dialog is shown while performing 
'Share' or 'Save to My Files' operations on documents of 
size greater than 5MB with hybrid user accounts.

PRO-1428 Both Original and Converted pdf attachments are shown in 
Sent Items folder when PDF action performed using 'Send 
and Protect'.

PRO-1448 DMS save functionalities are not working when user 
configured with 'legacy' server in Outlook and WCM.

PRO-1458 CR01148702 Outlook attachments are not updated when Forwarding 
email with existing attachments in Online Mode

PRO-1462 CR01148703 Conflict with Workshare Ribbon Add-in and ndOffice with 
the DocumentClose event

PRO-1469 Do you want to open the document from disk' message is 
displayed when iManage is configured with Legacy server 
and server is disconnected in WCM.

PRO-1470 iManage work' login dialog is displayed when saving the 
converted pdf document to legacy server when both 
work10 and legacy servers are configured in both outlook 
and WCM.
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Workshare Compare 9.5.3

The following are fixed customer change requests that have been validated for the 
Workshare 9.5.3 release:

CR # Ref Description

01110207 PRO-383
OpenText explorer stops working and is failing to browse to 
DM documents via Compare when screen display is set to 
either 125% or 150%.

01110921 PRO-398
Workshare Configuration Manager crashes when launching 
in Administrator mode.

01121371 PRO-616
“Test connection failed. Failed to connect to the server” is 
displayed when connecting to iManage Work 10 using a
SAML AD authentication method.

01129671 PRO-761
Error: “Document profile is invalid. Document type for this 
format is not available on iManage server” is displayed when 
attempting to save a .doc file to iManage.

01100041 PRO-126
Warning message: “A program is trying to access email 
address information stored in Outlook.”

01098438 PRO-231
Error: “No valid launch method is found” is displayed when 
launching the .wpf file from DM server.

01111205 PRO-409
Ability to allow PowerPoint comparison reports to be saved 
as an attachment to the original presentation in OpenText 
DM.

01113679 PRO-477
“Cache distribution lists” and “Cache distribution lists refresh 
rate (days)” options are no longer available within the 
Workshare Configuration Manager.

01120122 PRO-588
“The program can't start because Workshare.Messaging.dll is 
missing from your computer” is displayed when launching 
Compare for PowerPoint.

01120268 PRO-590
Document ID is displayed instead of Document Description 
when selecting documents from OpenText.

01121390 PRO-623
Document ID is displayed instead of Document Description 
when selecting documents from iManage FileSite.

01083253 PRO-663
Workshare add-in in Excel causes a warning in Excel when 
using the Query function.

01124544 PRO-675
Carbon Black software is flagging 
Workshare.Professional.msi contains malware during 
installation.
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CR # Ref Description

01129273 PRO-759
Error: “Use of the Workshare Clean API requires Workshare 
Protect Module License” is displayed when converting to PDF 
with “cleaning options” enabled.

01129780 PRO-767
Pro9 Update 7a – GDI leak occurs when using the iManage 
ribbon in Outlook.

01094095 PRO-91
Closing Word or Excel is taking 20-30 seconds when 
Workshare add-in is enabled.

01049562 PRO-201
Request to modify default comment in Save dialog to 
OpenText

01077212 PRO-307 Open PDF in Word results in a blank document.

PRO-628
Registry key not set when installing with Desktop Shortcut 
turned off.

01041969 PRO-458
Change file extension for PowerPoint Comparisons from 
*.wpf to *.wcfp to avoid conflict with Word Perfect

Workshare Compare 9.5.2

The following are fixed customer change requests that have been validated for the 
Workshare 9.5.2 release:

CR # FB # Description

01105098
Request to disable the ‘Change status information will not be 
saved’ warning that is displayed by default.

01100757 Zero byte file created when emailing redline as PDF.

01056318
‘Object reference not set to an instance of an object'’ error
when comparing heavily formatted PPT file.

01094624
‘Workshare DeltaView Mail Handler has stopped working’ 
error when emailing redline.

01097848 Software hangs when printing redline to PDF.

01105951
Compare crashes when comparing certain documents with 
tables and graphs.

01073195 42485
When comparing particular presentations, 'Index was out of 
range. Must be non-negative and less than the size of the 
collection.' error is displayed.

45657
The Workshare Getting Started Guide doesn't launch after re-
running the Workshare Configuration Assistant.
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Workshare Compare 9.5.1

The following are fixed customer change requests that have been validated for the 
Workshare 9.5.1 release:

CR # FB # Description

1037006 42894
Original Presentation and Modified Presentation fields are 
not cleared automatically when launching Workshare 
Compare for PowerPoint.

1073195 42485
'Index was out of range' error is displayed when comparing 
certain PowerPoint presentations.

Workshare Compare 9.5 GA

The following are fixed customer change requests that have been validated for the 
Workshare 9.5 GA release:

CR # FB # Description

01034312 34883
Redline Summary columns and description run off page when 
file name + path are too long

01042992 37082
Multiple instances of Word remain running when saving 
redline as PDF

01048471 37535
Enabling Show moved deletions option in Rendering Set 
Manager causing crashes

01049903 37953
Comments are missing when saving redline as Word 
document with Track Changes

01049923 37955
Comparing a document with multiple versions from DeskSite 
does not auto-populate the correct versions

01051283 38311 Unable to share documents with long filenames

01051797 38471
Sharing an iManage Word doc in Word causes the file to be 
named with DocID instead of the doc name

01053173 38704
'Workshare Compare has stopped working' when comparing 
certain Word documents

01056470 39500
Comments are showing as deleted and inserted incorrectly in 
TER view

01057775 39625
Custom fonts and macros not being saved to normal.dotm 
when Workshare add-in is enabled

01057792 39626
Failed to compare in fast mode certain Word documents and 
returns to comparison selection menu

40484
There is a spelling mistake in the 'Change Summary' button 
tooltip.
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CR # FB # Description

01063789 40861
Convert track change document to PDF automatically accepts 
changes

01065160 41054
Standard mode comparison takes longer when 'Cache Word' 
option is enabled in WCM.

01065167 41043
DOCVARIABLE fields not flattened when converting redline 
to PDF from ribbon

01069681 41926
Unable to save docs with long file-names into NetDocuments 
when include document descriptions is enabled

01072933 42372
Page layout changes from legal to letter and is missing 
paragraphs when saving fast mode redline to PDF

01072975 42399
Linked signature images are stripped and sent as 
attachments when sending email with ACN and IP enabled

42915
Compare without OCR' option is not available while 
comparing pdf documents from NetDocuments

01075270 42945
Fast comparison mode not available when using TLS 1.1 
and/or TLS 1.2 connection to NetDocuments

01083512 44356
Unable to re-share documents that was shared once in a 
Group on Connect.

01083513 44106
Blank page inserted and table overruns in TER view when 
comparing PDF documents with tables

Known Issues

The following are known issues in the Workshare Compare 9.5 release - for more 
information, please contact Customer Support.

Ref Description

PRO-1350
1143410

A warning message - “Workshare 9 was unable to retrieve the 
original/modified source document.” may be displayed when comparing 
PDF documents from an email.

PRO-1406
01145280

The comparison may fail when comparing specific documents containing 
comments and the Display comments in redline rendering option is 
enabled.

PRO-1511
01148122

When comparing specific documents, the list numbering font is changed to 
Calibri.

PRO-1518
01148594

Saving a comparison as a Word document with track changes can take a 
long time to process when specific documents have been compared.



Workshare Compare 9.5 Release Notes

19

Ref Description

PRO-987
A repair of Compare is forced when one of the default rendering sets are 
deleted using the Workshare Configuration Manager.

PRO-555/
01116873

When starting comparisons from OpenText Explorer, Compare does not 
display as the application in focus.

PRO-109/
01099537

The error ‘Failed to compare documents. Unable to convert documents.’ 
Is displayed when comparing specific scanned PDF documents.

PRO-22
The Reset Layout option is missing from the Quick Access Toolbar 
drop-down in Compare for PowerPoint.

01012100
The account or company name is not displayed in File > Help > About in 
Workshare Compare.

01018577
Worldox document footer stamps are not updated when saving a 
comparison via Save As in Workshare Compare.

01028440
Editing a rendering set on the fly does not prompt to save as a new set or 
overwrite the current rendering set.

40418
When comparing particular presentations, 'Index was outside the bounds 
of the array' error is displayed.

40430
When comparing presentations and at least one has the Opulent design 
theme applied, a ‘Color is not resolved yet’ error is displayed.

40469
In Compare for PowerPoint, a newly created comparison theme does not 
appear in the Select dropdown in the Home ribbon (Comparison 
Themes group).

40574
A user is not automatically logged into Professional after logging into the 
desktop app first (64-bit version only).

40597
The local file store dialog is displayed when browsing for files from the 
desktop app when a DMS is set as the default (64-bit version only).

41284
In Compare for PowerPoint, comparisons of DMS files are not listed in the 
recent comparison list (File > Open > Recent).

41547
When a PowerPoint presentation is run from the command line, the 
incorrect comparison theme is highlighted under the Select dropdown in 
the Home ribbon.
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Contact Info

For technical help and support on Workshare products, contact Workshare Customer 
Support:

support@workshare.com
EMEA: +44 207 539 1400
US: +1 415 590 7705

For sales enquiries, contact the Workshare Sales team:

sales@workshare.com
EMEA: +44 207 426 0000
US: +1 415 590 7700
APAC: +61 2 8220 8090

Workshare Ltd.
© 2018. Workshare Ltd. All rights reserved.
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